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1  : What is a computer in simple term? 
A : A calculating machine 
B : An electronic digital device 
C : An electronic typing machine 
D : An electronic hardware 

 
2  : Who invented the first computer? 
A : Thomas Alva Edison 
B : Bill Gate 
C : Charles Babbage 
D : Microsoft 

 
3  : Who created first programmable computer? 
A : Charles Babbage 
B : German Konrad Zuse 
C : Albert Einstein 
D : Benjamin Franklin 

 
4  : How a personal computer(PC) is designed? 
A : Can use many people at a time 
B : Can use only one person 
C : Only Government offices 
D : Only one person at a time 

 
5  : What was the name given to the first 
computer? 
A : Slide rule 
B : Difference engine 
C : ENIAC 
D : Calculator 

 
6  : Who is called father of modern computers? 
A : John Napier 
B : Edmund Gunter 
C : Blaise Pascal 
D : Charles Babbage 

 
7  : How difference engine provided its output? 
A : Through printer 
B : Through scanner 
C : Through photocopier 
D : Through USB device 

 
8  : Who introduced the personal computer (PC) 
for home and office use? 
A : Microsoft 
B : Apple 
C : IBM 
D : Dell 

 

9  : Which type of computers used in banks to 
store and retrieve core banking transactions? 
A : Mobile phones 
B : Centralized server computers 
C : Tablet computers 
D : Micro-computers 

 
10  : What are the physical components of a 
computer? 
A : Monitor, Keyboard, MS word 
B : Mouse, Printer, keyboard 
C : Monitor, Motherboard, system software 
D : Keyboard, Mouse, MS office 

 
11  : What is the name given to the physical 
components of a computer collectively? 
A : Software 
B : Hardware 
C : Malware 
D : Junk ware 

 
12  : Which component makes a computer to 
work through commands? 
A : Software 
B : Hardware 
C : Malware 
D : Junk ware 

 
13  : What is the common name of a group of 
component physically available and can be seen in a 
computer? 
A : Software 
B : Malware 
C : Hardware 
D : Junk ware 

 
14  : What category the Keyboard, mouse, 
scanner, stylus, light pen, etc are classified? 
A : Input unit 
B : Central processing unit 
C : Output unit 
D : Processing unit 

 
15  : What is the name of the unit which stores 
data in computer? 
A : Program 
B : Software 
C : Hardware 
D : Memory 
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16  : Where the processing work of a computer 
takes place? 
A : Input unit 
B : Central Processing Unit (CPU) 
C : Output unit 
D : Inbuilt software 

 
17  : Which one is the primary memory in 
computer? 
A : Hard disk 
B : Mother board 
C : Ram 
D : Rom 

 
18  : What is called secondary memory or 
storage in computer system? 
A : Central Processing Unit 
B : Hard Disk 
C : System software 
D : Application software 

 
19  : What is called a single user computer 
system having moderately powerful 
microprocessor? 
A : Workstation 
B : Personal Computer (PC) 
C : Mini computer 
D : Super computer 

 
20  : What is the name of the monitor which can 
be used as an input device? 
A : CRT Monitor 
B : Touch screen monitor 
C : LCD Monitor 
D : LED monitor 

 
21  : Which are some important output devices? 
A : Keyboard and cables 
B : Printer and Monitor 
C : Speaker and Mic 
D : Mouse and cables 

 
22  : What is the name of the computer 
hardware device? 

 
A : Laptop 
B : Photo album 
C : Scanner 
D : Touch screen 

 
23  : What is the primary unit to enter text to 
computer? 
A : Keyboard 
B : Mouse 
C : Mic 
D : Digital Camera 

 
24  : What is the name of this input device? 

 
A : A detachable Mic 
B : A detachable webcam 
C : A joy stick 
D : Lighting device 

 
25  : Which category the Monitor, printer, 
plotter, etc. classified? 
A : Input category 
B : Central processing category 
C : Output category 
D : Control category 
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26  : What is the name of a printer that work by 
banging a head or needle against an ink ribbon to 
make a mark on paper? 
A : Laser printer 
B : Inkjet printer 
C : Colour printer 
D : Impact Printer 

 
27  : Which type of monitors has less negative 
environmental impact when disposed? 
A : LCD Monitor 
B : LED Monitor 
C : CRT Monitor 
D : Touch screen 

 
28  : What is the name of the storage device? 

 
A : Sim card 
B : Data card 
C : Memory card 
D : USB flash drive 

 
29  : What is the storage capacity of a Floppy 
drive shown? 

 
A : 700 MB 
B : 4.7 GB 
C : 700 KB 
D : 1.44MB 

 

30  : What is the storage capacity of a DVD? 
A : 700 KB 
B : 700 MB 
C : 4.7 GB 
D : 2 - 512 GB 

 
31  : What is the name of this storage device? 

 
A : Memory card 
B : Magnetic tape 
C : Pen drive 
D : Floppy drive 

 
32  : What is called the brain of the computer? 
A : System software 
B : Application software 
C : Hard disk 
D : Central Processing Unit (CPU) 

 
33  : Which component holds temporary storage 
for data and programs that are accessed by CPU? 
A : RAM (Random Access Memory) 
B : ROM ( Read Only Memory) 
C : Hard Disk 
D : Mother board 

 
34  : What is the solution for enhanced system 
performance? 
A : Increase ROM 
B : Increase storage capacity of Hard disk 
C : Use more capacity RAM 
D : Add additional Mother board 

 
35  : How many bit make a Byte? 
A : 1024 KB 
B : 8 bit 
C : 1024 MB 
D : 1024 GB 
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36  : What is the name of the component 
contains slots for fixing/ connecting processor, main 
memory (RAM), hard disk, CD/DVD drive, etc.,? 
A : Mother board 
B : Bread board 
C : Key board 
D : Dash board 

 
37  : Which software act as a middle layer 
between hardware and user applications? 
A : Application software 
B : Database software 
C : System software 
D : Common utility program 

 
38  : What is the name of the wireless mouse? 
A : Digital mouse 
B : Optical mouse 
C : Conventional mouse 
D : Advanced mouse 

 
39  : Which hardware component controls the 
cursor on screen? 
A : Keyboard 
B : Mouse 
C : Speed 
D : Function 

 
40  : Hard disk is measured by its? 
A : Weight 
B : Capacity to store data 
C : Cost 
D : Size 

 
41  : What are the different types of storage 
devices? 
A : Floppy Disk Drive, Hard Disk Drive and CPU 
B : D Memory Card, DVD/CD and Mother Board 
C : USB Flash Drive, Hard Disk Drive and Memory 
Card 
D : RAM, Video Tape and Floppy Disk Drive 

 
42  : What are the output devices for audio 
signals? 
A : Speaker and printer 
B : Headphones and mic 
C : Speaker and Monitor 
D : Speaker and headphones 

 

43  : Which category, the Dot matrix printer 
belongs? 
A : Monitor 
B : Scanner 
C : Non-impact type printer 
D : Impact type printer 

 
44  : Which category, Laser printer, ink jet 
printer, thermal printer , plotter belongs? 
A : Light copy 
B : All in one printer 
C : Non-impact type printer 
D : Impact type printer 

 
45  : What is the name of a Digital copy of a 
document stored in secondary storage device (like 
hard disk, floppy disk, CD, DVD, pen drive, SD card, 
etc.,? 
A : Light copy 
B : Hard copy 
C : Soft copy 
D : Hot copy 

 
46  : What is the name this cables? 

 
A : USB connector 
B : PS/2 cables 
C : Network cables 
D : VGA cables 
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47  : What is the name this port? 

 
A : Network cable port 
B : PS/2 port 
C : USB cable port 
D : Interface cable port 

 
48  : What is the name this cable? 

 
A : Power cable 
B : PS/2 cable 
C : USB cable 
D : Network cable 

 
49  : What is the name of this cable? 

 
A : Speaker cable 
B : Printer cable 

C : CPU cable 
D : Ethernet cable 

 
50  : Which pair of cables is shown in the 
picture? 

 
A : Male and female interface cable 
B : Male and female power cable 
C : Male and female USB cable 
D : PS/2 cables 

 
51  : What is the name of this component? 

 
A : Switched mode power supply 
B : Systematic Modular Power Supply 
C : Supply mode power supply 
D : System made power supply 

 
52  : What is the name of this device? 

 
A : CD Drive 
B : DVD Drive 
C : Hard disc 
D : Floppy drive 
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53  : What is the name of the component 
shown? 

 
A : ROM Chip 
B : Audio Chip 
C : RAM chip 
D : Storage chip 

 
54  : Which part of the computer serves as a 
single platform to connect all the parts of the 
Computer together? 
A : Mother Board 
B : Central Processing Unit (CPU) 
C : Cabinet 
D : Cables 

 
55  : What is the basis of Pitman’s Shorthand? 
A : Alphabets 
B : Sounds 
C : Spelling 
D : Pronunciation 

 
56  : What is the most popular system of 
shorthand writing? 
A : Sloan Duployan System 
B : Pitman’s Shorthand 
C : John Robert Gregg’s System 
D : Morse Code 

 
57  : What are the skill requirements for clearing 
the Staff Selection Commission Examination? 
A : A speed of 80-100 wpm in shorthand and 40 
wpm in typing 
B : A speed of 60 wpm in shorthand and 30 wpm 
in typing 
C : A speed of 40 wpm in both shorthand and 
typing 
D : A speed of 60 wpm in both shorthand and 
typing 

 
58  : Which is the highest position a 
stenographer can climb to? 
A : Private Secretary 
B : Principal Private Secretary 

C : Senior Private Secretary 
D : Personal Assistant 

 
59  : Which makes a stenographer very efficient? 
A : Good spoken English and proficiency in a 
local language 
B : Ability to write grammatically correct 
sentences 
C : Accuracy and speed in shorthand and typing 
and proficiency in English 
D : High speed in shorthand and typing 

 
60  : What are Explodents? 
A : Sounds produced when air escapes in a 
continuous stream 
B : Sounds produced when air is forced out 
suddenly 
C : Sounds produced when air escapes through 
nose 
D : Sounds produced by blending with other 
consonants 

 
61  : How is ‘chay’ written? 
A : Thin downstroke at 30o angle from the 
perpendicular 
B : Thick downstroke at 30o angle from the 
perpendicular 
C : Thin upstroke at 30o angle from the 
horizontal 
D : Thick upstroke at 30o angle from the 
horizontal 

 
62  : What should be the length of a stroke? 
A : Half of an inch 
B : 1/3rd of an inch 
C : 1/4th of an inch 
D : 1/6th of an inch 

 
63  : How many consonants (strokes) are there 
in Pitman’s Shorthand? 
A : 28 
B : 26 
C : 24 
D : 12 
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64  : How many consonant sounds are there in 
Pitman’s Shorthand? 
A : 6 
B : 12 
C : 24 
D : 26 

 
65  : Which strokes are never written upward? 
A : Light strokes 
B : Thick strokes 
C : CH 
D : Ar 

 
66  : What is an intervening vowel? 
A : Vowel occurring before a stroke 
B : Vowel occurring at the end of a stroke 
C : Vowel occurring between any two strokes 
D : Vowel occurring between two curved strokes 

 
67  : How many are the vowels, according to 
Pitman’s Shorthand? 
A : 26 
B : 24 
C : 12 
D : 6 

 
68  : Where is a third-place intervening written? 
A : Before the second stroke at the end 
B : After the first stroke at the end 
C : After the second stroke at the end 
D : After the first stroke at the beginning 

 
69  : Which is correct? 
A : The vowel determines the position of an 
outline 
B : The first position is on the line 
C : The second position is above the line 
D : The third position is through the line 
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70  :  What is windows in computer terms? 
A : An application software 
B : A collection of programs known as an 
operating system (OS) that controls a PC (personal 
computer). 
C : Hardware 
D : Hardware and software 

 
71  : What is MS DOS stands for? 
A : MiniSoft Disk Operating System 
B : MicroSoft Disk Operating Standard 
C : MicroSoft Dirty Operating System 
D : MicroSoft Disk Operating System 

 
72  : Which operating system has the largest 
number of installations for desk- top computers? 
A : Windows 
B : Android 
C : Mac OS X 
D : UNIX 

 
73  : Which is the most dominant operating 
system in mobile phones? 
A : Windows mobile 
B : iOS 
C : Android 
D : Blackberry OS 

 
74  : What is the name of the shortcuts visible on 
the Desktop? 
A : Clipboard 
B : Desktop icons 
C : Download icons 
D : Document icons 

 
75  : What is called the thin strip (usually placed 
at bottom) of Windows desktop, containing several 
important icons? 
A : Menu bar 
B : Title bar 
C : Status bar 
D : Task bar 

 
76  : What is called the special button at the left 
edge of task bar, used to open many programs? 
A : Stop menu 
B : Popup menu 
C : Start button 
D : File menu 

 

77  : Where can you find the list of running 
programs? 
A : Start menu 
B : Quick launch icons, 
C : All programs 
D : Task bar 

 
78  : Where can you find the page number of the 
currently running programs? 
A : Menu bar 
B : Title bar 
C : Status bar 
D : Task bar 

 
79  : Which one is the default folder for saving 
document files created by a user? 
A : Desktop 
B : My Documents/ Documents 
C : Pictures 
D : Music 

 
80  : Which is the default folder for image and 
drawing files related to a user? 
A : Desktop 
B : My Documents/ Documents 
C : Pictures 
D : Music 

 
81  : Which is the default folder to save content 
downloaded from the Internet? 
A : Downloads 
B : My Documents/ Documents 
C : Pictures 
D : Music 

 
82  : What is the shortcut for opening for 
Windows Explorer? 
A : Windows+E 
B : Windows+R 
C : Windows+F 
D : Windows+L 

 
83  : What is the shortcut to copy a file in 
Windows Explorer? 
A : Ctrl+X 
B : Ctrl+C 
C : Ctrl+V 
D : Ctrl+A 
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84  : What is the shortcut for cut a file in in 
Windows Explorer? 
A : Ctrl+X 
B : Ctrl+C 
C : Ctrl+V 
D : Ctrl+A 

 
85  : Which is the shortcut In Windows Explorer, 
to paste a file which has already been cut or 
copied? 
A : Ctrl+X 
B : Ctrl+C 
C : Ctrl+V 
D : Ctrl+A 

 
86  : What is the command to create Desktop 
shortcut for a file? 
A : Send To >Desktop 
B : Send To >Drive name 
C : Send To >Compressed/Zipped archive 
D : Send To >Bluetooth Device 

 
87  : What is to be done to write a file in an 
empty CD or DVD? 
A : Send To >Desktop 
B : Send To >Drive name 
C : Send To >Compressed/Zipped archive 
D : Send To >Bluetooth Device 

 
88  : What is GUI means? 
A : Guided Unit Interface 
B : Graphical User Interface 
C : Guaranteed Ultimate Information 
D : Good User Interference 

 
89  : What appears when you click ʹStartʹ menu 
in windows? 
A : A popup menu appears 
B : MS Word program starts 
C : A blank note pad appears 
D : Windows update starts 

 
90  : When you type a wrong password, what 
message will appear on the screen? 
A : Password is incorrect 
B : Username is incorrect 
C : User name or password is incorrect 
D : Try again 

 

91  : Where to find the ‘Deleted’ items? 
A : In the Documents 
B : In the recycled bin 
C : In my computer 
D : Not seen anywhere 

 
92  : How to restore the deleted files? 
A : Restore from programme files 
B : Restore from Documents 
C : Restore from Recycled bin 
D : Restore from deleted files 

 
93  : What you see when you click on the office 
button/file menu? 
A : MS word programme appears 
B : A dropdown menu appears 
C : Whole programme appears 
D : Task bar appears 

 
94  : Where to find ʹSave Asʹ option in the 
computer? 
A : In the start button 
B : In the Task bar 
C : In the File menu/office button on the ribbon 
D : In the Insert menu 

 
95  : Where to find add a printer option? 
A : In start menu 
B : In Device and Printers program 
C : In Control Panel 
D : In File tab of the menu bar 

 
96  : Where to find current date and time? 
A : Start menu 
B : Title bar 
C : Right side of the task bar 
D : In the Control panel 

 
97  : What happens when you press Ctrl+A in 
text typing? 
A : Typed text disappears 
B : Typed text becomes bold letters 
C : Types text move to next page 
D : Typed text get selected 
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98  : How to type special characters like @, #, &, 
(, ^, in the text? 
A : Use caps lock and type the symbol 
B : Use Ctrl key and type the symbol 
C : Use Alt key and type the symbol 
D : Press and hold shift key and type the symbol 

 
99  : What is called, in paint program, the white 
drawing area? 
A : White board 
B : Drawing Board 
C : Canvas 
D : White screen 

 
100  : How can we change date and time in 
windows? 
A : From My computer 
B : From Default program 
C : Click open date and time icon from task bar 
D : From the start menu 

 
101  : Where is Screen saver option is available? 
A : Programme files 
B : Device and Printers 
C : View menu of the standard menu bar 
D : In the control panel 

 
102  : Which one is the removable Disk from the 
list given? 
A : Local Disc (C) 
B : Software 
C : Pen drive or Floppy disc 
D : Local Disc (F) 

 
103  : What is the option to change the desktop 
background (wallpaper)? 
A : Control panel→Program option 
B : Control panel→Display option 
C : Control panel→Personalization option 
D : Control panel →Ease of Access 

 
104  : What is the shortcut key to move back to 
previous folder in Windows/File Explorer? 
A : Alt+Enter 
B : Alt+Left Arrow 
C : Shift+Delete 
D : Shift+F10 

 
105  : What is the shortcut key for display start 
menu? 

A : Ctrl+Tab 
B : Ctrl+F4 
C : Ctrl+Esc 
D : Ctrl+Shift+Esc 

 
106  : What is to be installed to run a peripheral 
unit like scanner, printer or webcam? 
A : Connector 
B : Driver 
C : Conductor 
D : Resistor 

 
107  : What is called, Memory which can be 
written only once? 
A : RAM 
B : ROM 
C : EPROM 
D : EEPROM 

 
108  : What message is displayed after inserting 
the Windows installation media (like CD, DVD or 
pen drive), 
A : Press any key to boot from CD/ DVD 
B : Press Ctrl+Alt+Delete 
C : Press left button of mouse 
D : Press centre button of mouse 

 
109  : What action takes place on completion of 
installation of Windows? The Computer starts? 
A : Rebooting 
B : Keeps on processing 
C : Keeps on beeping 
D : Plays music 

 
110  : Where the files deleted from the hard disk 
will be placed? 
A : It will be deleted for ever 
B : It will be placed in the system itself 
C : It will be placed dust bin temporarily 
D : It will be placed in the recycled bin 
temporarily 
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111  : What happens when you delete an icon 
from the desk top? 
A : The icon along with the file associated with it 
disappears 
B : The icon moves to the hard disk 
C : The file associated with the icon get deleted 
D : The icon get deleted, but the file associated 
with it remains 

 
112  : Where to find Network and Internet? 
A : Programs 
B : System software 
C : Control panel 
D : Default programs 

 
113  : Which option has to be selected from the 
programme menu to connect a printer? 
A : My computer 
B : Control panel 
C : Device and printers 
D : My documents 

 
114  : Which software automatically corrects 
spelling and grammar? 
A : System software 
B : Word processing software 
C : Antivirus software 
D : Spell check 

 
115  : Which feature repeats the content of the 
document? 
A : Select all option 
B : Save option 
C : Save as option 
D : Copy paste option 

 
116  : What is Microsoft Office? 
A : System software alone 
B : Application and system software 
C : Accounting software 
D : Application software 

 
117  : What are the steps to shut down the 
computer safely? 
A : Disconnect power supply 
B : Switch off the CPU 
C : Close all programmes- click start – shutdown 
D : Switch off the monitor 

 

118  : Where to find user accounts? 
A : In the programme files 
B : In the control panel 
C : In the office button 
D : Windows explorer 

 
119  : Which is the most common form of 
permanent data storage? 
A : Hard Disc 
B : Mother board 
C : Compact disc 
D : Magnetic disc 

 
120  : Where is in desk top task bar notification 
area is found? 
A : Left edge 
B : Top edge 
C : Right edge 
D : Bottom edge 

 
121  : Which mouse action is used to move an 
object from one location to another? 
A : Left click 
B : Right click 
C : Double click 
D : Drag and drop 

 
122  : Which printer prints characters as 
combination of dots? 
A : Laser printer 
B : Ink-jet printer 
C : Bubble printer 
D : Dot matrix printer 

 
123  : Which icon in control panel is used to 
change the appearance of the screen? 
A : Ports 
B : Devices 
C : Display 
D : Appearance and personalisation 

 
124  : Which is the graphic development tool 
that comes with MS Windows operating system? 
A : MS Paint 
B : MS word 
C : MS Excel 
D : MS power point 
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125  : Which tool allows the user to create free 
hand lines in MS paint? 
A : Curve 
B : Brush 
C : Pencil 
D : Eraser 

 
126  : Where is zoom bar located in the windows 
screen? 
A : Minu bar 
B : Title bar 
C : Scroll bar 
D : Task bar 

 
127  : Which icon helps you to create user name 
and password in your system? 
A : User accounts and family safety 
B : System and security 
C : Hardware and sounds 
D : Programs 

 
128  : What is the meaning of this message? 

 
A : The document is not saved 
B : Changes in the document not saved 
C : Rename the document 
D : The document cannot be closed 

 
129  : Where you can see the image shown? 

 
A : Desk top 
B : Task bar 
C : Control panel 
D : Programs 

 

130  : Which is correct? 
A : Grammalogues are also known as word-
letters 
B : Logograms are also known as Letter-words 
C : Logograms are single signs to represent 
frequently occurring words 
D : Logograms are represented only by strokes 

 
131  : What are the positions in which logograms 
can be written? 
A : First position 
7B : Second position 
C : Third position 
D : In all positions 

 
132  : Which 1/3rd of a stroke represents ‘and’? 
A : 1/3rd of Ray on the line 
B : 1/3rd of chay on the line 
C : 1/3rd of Ray above the line 
D : 1/3rd of chay on the line 

 
133  : What do you know of a contraction? 
A : Frequently occurring word represented by a 
single sign 
B : Frequently occurring word represented by 
more than one stroke 
C : Contractions are formed by omission of initial 
stroke 
D : Strokes cannot be joined to logograms to 
form contractions 

 
134  : How is tick ‘the’ written? 
A : As a light heavy upward tick joined to a 
preceding word 
B : ‘on’ and but’ should slope a little when tick 
‘the’ is joined 
C : As a heavy slanting downward tick joined to a 
preceding word 
D : Tick ‘the can be used initially 

 
135  : What is a Triphone? 
A : Union of two syllables in one syllable 
B : Single Sign representing three vowels 
C : Union of diphthong and vowel in two 
syllables 
D : Union of three vowels in two syllables 
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136  : How is abbreviated ʹWʹ represented? 
A : By a left semi circle before K, G, M, R 
B : By a left semi circle at the beginning of all 
strokes 
C : By a right semi circle at the beginning of K, G, 
M, R 
D : By a left semi circle at the end of some 
strokes 

 
137  : Which are the strokes before which 
abbreviated ʹWʹ is employed? 
A : P, B, T, D, N 
B : K, G, M, Ray, Ar 
C : J, V, TH, S, Z 
D : SH, ZH, F, L, CH 

 
138  : What is a Diphthong? 
A : Union of two vowels in two syllables 
B : Union of two vowels in one syllable 
C : Two vowels occur side by side without 
uniting 
D : Diphthongs signs are written thick 

 
139  : Which diphthong signs are written in the 
third place? 
A : OI, OW 
B : I, U 
C : OW, U 
D : I, OI 

 
140  : Which stroke joins with ʹIʹ diphthong 
finally? 
A : J 
B : M 
C : N 
D : L 

 
141  : Which is correct with regard to 
employment of ʹOWʹ diphthong? 
A : OWʹ diphthong is joined initially to stroke ʹLʹ 
B : Iʹ diphthong cannot be employed finally to 
stroke ʹLʹ 
C : Uʹ diphthong should always be joined with 
the right motion 
D : OIʹ diphthong cannot be joined to stroke ʹLʹ 
initially 
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142  : Which is the longest key in the keyboard? 
A : Shift key 
B : Control key 
C : Backspace key 
D : Space bar 

 
143  : Which button removes a character to the 
left of cursor position? 
A : Space bar 
B : Enter 
C : Backspace 
D : Tab 

 
144  : What appears on the screen when we 
press Ctrl+P after entering a text? 
A : Entire page get deleted 
B : The text get selected 
C : The entire text moves down 
D : Print dialogue box appears 

 
145  : What is the shortcut keys for save option? 
A : Holding Ctrl + C 
B : Holding Ctrl + S 
C : Holding Ctrl + Alt + Shift key 
D : Holding Ctrl + A 

 
146  : What is Ctrl + end function? 
A : The cursor moves to the end of the 
document 
B : The cursor moves to the beginning of the 
typing line 
C : The cursor moves to the next page 
D : The cursor disappears 

 
147  : What happens when you press page down 
key? 
A : The cursor moves down to the next page 
B : Go to the end page of the document 
C : The cursor moves one line down 
D : The entire document go down 

148  : What is the name of the image you see? 

 
A : Calculator 
B : Billing machine 
C : Numeric key pad of keyboard 
D : Numbers of key board 

 
149  : Which key button stops or resumes the 
boot process? 
A : Caps lock 
B : Print screen 
C : Scroll lock 
D : Pause / Break 

 
150  : Which key toggles number pad ON or 
OFF? 
A : Num lock 
B : Caps lock 
C : Scroll lock 
D : Esc 

 
151  : Which keys that can move the cursor up, 
down, left or right? 
A : Enter key 
B : Shift key 
C : Arrow keys 
D : Function keys 

 
152  : What is the name of the series of keys 
named F1 ... F12 are called? 
A : Function keys 
B : Scroll keys 
C : Number keys 
D : Navigation keys 

 
153  : Which key button opens the start menu? 
A : Windows key 
B : Ctrl 
C : Alt 
D : F1 

 



Stenographer and Secretarial Assistant– Semester 1 Module 3 - Keyboard functions 
and Formation of words 

Reviewed and updated on: 01st November 2019 Version 1.1 
 
154  : Which key opens help function? 
A : Windows key 
B : Ctrl 
C : Alt 
D : F1 

 
155  : Which button of a mouse opens a context 
menu normally? 
A : Left 
B : Right 
C : Centre 
D : Bottom 

 
156  : Which button of a mouse act as a scroll 
button? 
A : Left 
B : Right 
C : Centre 
D : Bottom 

 
157  : Which key button ends current line of 
input? 
A : Space bar 
B : Enter 
C : Backspace 
D : Tab 

 
158  : Which button takes a screen shot and 
copies it to clipboard or saves it to a file? 
A : Caps lock 
B : Print screen 
C : Scroll lock 
D : Pause/break 

 
159  : Which key helps to moves out of current 
screen or terminates current operation.? 
A : Num lock 
B : Arrow 
C : Scroll lock 
D : Esc key 

 
160  : What happens if you press the delete key 
when your cursor is in the middle of a sentence? 
A : Complete sentence is deleted 
B : The text next to the cursor is get selected 
C : Left side of the text deleted 
D : The characters next right to the curser is 
deleted 

 

161  : What happens when you press the back 
space key in the middle of a text? 
A : Deletes one character or space to the left of 
the 
B : Entire text is moved backwards 
C : Blank space is created 
D : Cursor moves to the next paragraph 

 
162  : What happens when you press the enter 
key? 
A : The cursor moves to the end of the typing 
line 
B : The cursor moves to the next line of typing 
C : The cursor moves to the top of the page 
D : The cursor moves to the bottom of the page 

 
163  : What is the name of this key button? 

 
A : Central key 
B : Character key 
C : Function key 
D : Control key 

 
164  : What is the name of the row of keys 
shown in computer terms? 

 
A : Central row of key board 
B : Middle row 
C : Home row 
D : Fingering row 

 
165  : When is tick ʹHʹ employed? 
A : Medially in words 
B : Finally in phrases 
C : Before M, L, Ar 
D : Before K, G 
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166  : Which consonants have two forms? 
A : L and SH 
B : R and H 
C : F and V 
D : Th and TH 

 
167  : When is downward ʹRʹ written? 
A : Initially when followed by a vowel 
B : Initially when preceded by a vowel 
C : Finally when followed by a vowel 
D : Medially after a straight stroke 

 
168  : When is upward ʹRʹ written? 
A : Initially when followed by a vowel 
B : Initially when preceded by a vowel 
C : Finally when R is not followed by a vowel 
D : Initially before stroke M 

 
169  : What are the uses of tick ʹHʹ? 
A : It can be employed in the middle of a word 
B : It can be employed in phrases 
C : It can be employed before stroke R (up) 
D : It can be employed initially when followed by 
K/G 

 
170  : Which option is correct? 
A : Dot H is employed in phrases 
B : Dot H is employed in words 
C : Tick H is not employed in phrases 
D : Tick H is employed in words 

 
171  : What is Phraseography? 
A : Writing two words together without lifting 
the pen 
B : Writing two or more words together without 
lifting the pen 
C : Writing two words together with vowels 
D : Writing two or more words with vowels

172  : Which is true of a Phraseogram? 
A : Position of all the words change 
B : Position of the first word does not change 
C : Word following ‘I’ cannot be written above 
the line 
D : Word following ‘with’ cannot be written on 
the line 

 
173  : How will you change the verb ‘took’ in the 
Passive Voice? 
A : Is taken/are taken 
B : Am taken/are taken 
C : Are taken/were taken 
D : Was taken/were taken 

 
174  : Which sentence is in the present perfect 
continuous tense? 
A : He has read the book 
B : He has been reading the book 
C : He had been reading the book 
D : He will have been reading the book 

 
175  : What is the passive voice for “He has paid 
the money”? 
A : The money has been paid by him 
B : The money had been paid by him 
C : The money is being paid by him 
D : They money was being paid by him 

 
176  : Which tense in Passive Voice have ‘being’ 
before past participle? 
A : Simple Present Continuous Tense 
B : Simple Past Continuous Tense 
C : Simple Future Continuous Tense 
D : Continuous Tenses of present, past and 
future 
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177  : Where we can find rulers in MS Word? 
A : All sides of the document 
B : Top and bottom of the document 
C : Top and left side of the document 
D : Only left side of the document 

 
178  : What is the shortcut key for Bold letters? 
A : Shift + B 
B : Alt + B 
C : Tab + B 
D : Ctrl + B 

 
179  : What option has to be selected to save an 
existing document in a different name? 
A : Save command 
B : Save as option 
C : Both Save and Save As option 
D : Auto save 

 
180  : What is the sequence to open a saved 
document to add heading? 
1.On the file menu, click open 
2. The open dialogue box displayed 3. Double click 
the name of the file 4.Select the drive and folder on 
which the file is saved 
A : 1-2-3-4 
B : 1-3-2-4 
C : 1-3-4-2 
D : 1-2-4-3 

 
181  : What is the sequence to take a print out of 
the first paragraph of a document? 
1. In the printer dialogue box , click selection 
2. On the drop down file menu, click print 
3. Select the first paragraph of the document 
4. Click OK 
A : 2-3-4-1 
B : 3-1-4-2 
C : 3-4-2-1 
D : 3-2-1-4 

 
182  : What could be the reason while inserting 
some text in the middle of a paragraph, the existing 
content is deleted? 
A : The document is in the Insert mode 
B : The document is in the Delete mode 
C : The document is in the overtype mode 
D : The document is in the backspace mode 

 

183  : What is called for moving around the 
document? 
A : Editing 
B : Exploring 
C : Navigation 
D : Orientation 

 
184  : What is called align text to both the left 
and right margins? 
A : Align left and right 
B : Alignment 
C : Modify 
D : Justify 

 
185  : What is the full for WYSWYG In Graphical 
User Interface (GUI) based Programs? 
A : Whatever You See, Wherever You Get 
B : What You See, What You Get (a) 
C : Whichever You See, What You Get 
D : Wherever You See, What You Get 

 
186  : How In MS Word, grammatical errors are 
highlighted? 
A : Bold text 
B : Green underline 
C : Red underline 
D : Italic text 

 
187  : What is called the text or image which 
appears faintly in the background of a Page? 
A : Water mark 
B : Trade mark 
C : Copy right 
D : Embossing 

 
188  : Which menu permits insertion of tables, 
images, drawing objects and hyperlinks, headers 
and footers in 
MS Word? 
A : Home 
B : Insert 
C : Page Layout 
D : References 
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189  : What is the shortcut key to cut the 
selected content in MS Word? 
A : Alt+H+FO 
B : Ctrl+X 
C : Ctrl+C 
D : Ctrl+V 

 
190  : What document it displays on opening MS 
Word (without clicking on a target document)? 
A : Previous 
B : Formatted 
C : Completed 
D : Blank / New 

 
191  : What is called when the width of paper is 
smaller and height of paper is large in orientation? 
A : Landscape 
B : Portrait 
C : Narrow 
D : Wide 

 
192  : Which option is available to print multiple 
copies of a document(divide by set) in print dialog? 
A : Collate 
B : Scale 
C : Printer properties >Finishing->Print on both 
sides 
D : Properties >Paper/Quality 

 
193  : Which option may be used to print both 
sides of paper in print dialog? 
A : Collate 
B : Scale 
C : Printer properties 
D : Properties >Paper/Quality 

 
194  : Name the dialogue box in the given 
picture? 

 
A : Font size 
B : Top and bottom margin 

C : Line spacing button 
D : Left and right margin 

 
195  : Which tab opens the text box in MS word 
program? 

 
A : Page layout menu 
B : Home menu 
C : Review menu 
D : Insert tab/menu 

 
196  : What is to be done to get a letter 
continuously in the document? 
A : Type the letter continuously 
B : Press and hold the key 
C : Type the letter and copy paste 
D : Type the key and hold right arrow key 

 
197  : What will be reason when you operate 
numerical pad no impression is visible on the 
monitor? 
A : Key pad is not operational 
B : Proper pressure not applied to the key 
button 
C : Number lock button is in off position 
D : Wrong fingering 

 
198  : What is the name of a paper copy of the 
document? 
A : Light copy 
B : Soft copy 
C : Hot copy 
D : Hard copy 

 
199  : Where do we paste the print screen 
objects to crop the desired picture? 
A : MS Office tools 
B : MS Word 
C : MS Publisher 
D : MS Paint 
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200  : Which tab in the menu bar open this tools 
in MS word program? 

 
A : View 
B : Home 
C : Insert 
D : Page layout 

 
201  : What is the purpose of the tool shown in 
the picture? 

 
A : Change case (upper, Lower) 
B : Change to uppercase 
C : Change Font colour 
D : Change page colour 

 
202  : How is ʹZʹ represented? 
A : Initial sound of Z is represented by circle S 
B : Initial sound of Z is represented by stroke Z 
C : Medial Z is represented by stroke 
D : Final Z followed by vowel is represented by 
circle 

 
203  : How do you represent the sound of S/Z? 
A : By a small circle initially 
B : By a small circle finally 
C : By a small circle medially 
D : By a small circle medially or finally 

 
204  : Which is correct? 
A : Circle S is written outside the curved strokes 
B : Circle S is written outside the angle between 
two straight strokes 
C : Circle S is written inside the angle between 
two straight strokes 
D : Circle S is written with the right motion to 
straight strokes 

 

205  : When is circle ʹSʹ not employed initially? 
A : When S is followed by another S/Z 
B : When initial sound is Z 
C : When initial S is preceded by a vowel 
D : When a diphthong precedes S 

 
206  : How is stroke ʹLʹ written before/after 
circle ʹSʹ attached to a curve? 
A : Stroke L is written downward before circle S 
B : Stroke L is written upward before circle S 
C : Stroke L is written upward after circle S 
D : Stroke L is always written in the same motion 
as the circle 

 
207  : What do you know of SW circle? 
A : It is a small circle written with the left motion 
B : It is written with the right motion to straight 
strokes  
C    :    It is a large circle employed initially 
D    :    It can be employed initially and medially 

 
208  : Which sounds are represented by a large 
circle? 
A : A large medial circle represents S-S sound 
B : A large medial circle represents S-Z sound 
C : A large final circle represents S-S sound 
D : A large medial/final circle represents S-S or S-
Z sound

209     :    When is ST loop employed in a word? 
A : Initially and medially 
B : Medially and finally 
C : Initially, medially and finally 
D : Initially and finally

210     :    Which is correct? 
A : ST loop represents ST sound only 
B : ST loop is about 2/3rd the length of a stroke 
C : STR loop cannot be employed finally 
D : ST loop cannot be employed if a vowel occurs 
between S and T 
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211     :    How is R hook written to straight strokes? 
A : As a large hook 
B : With left motion 
C : Initially 
D : Finally

212     :    How is L hook written to strokes? 
A : As a large initial hook to straight strokes 
B : Written initially to straight strokes with right 
motion 
C : As a small initial hook to curved strokes 
D : As a small initial hook to straight strokes

213  : When do you use the right curves of 
Fl/VL? 
A : After straight down strokes 
B : After straight upstrokes 
C : After curved down strokes 
D : After horizontal stroke M

214  : When do you use left forms of curved 
hooked strokes? 
A : When standing alone, if a vowel follows 
B : When standing alone, if a vowel precedes 
C : With strokes written towards the right 
D : With strokes written upward

215  : How is an intervening third-place dot 
vowel represented? 
A : By a small disjointed circle after the stroke 
B : By a small disjointed circle before the stroke 
C : By a small disjointed circle before or after 
stroke 
D : By a dot after or before stroke

216  : How will you represent intervening vowels 
between stroke and its initial hook? 
A : First place dash vowel is represented by small 
circle 
B : Third place dash vowel is represented by 
small circle 
C : Diphthong is represented by striking the 
small circle through 
D : Dot vowel is represented by striking the small 
circle through 

 
217  : Which option is correct? 
A : MP/MB is used when PR/BL immediately 
follows M 
B : MP/MB is not used when PR/BL immediately 

follows M 
C : Initial hook cannot be attached to MP/MB 
D : Final hook cannot be attached to MP/MB 

 
218  : Which word meaning ʹstaffʹ is spelt 
correctly? 
A : Personal 
B : Personel 
C : Personnal 
D : Personnel 

 
219  : Which word is spelt correctly? 
A : Physition 
B : Physision 
C : Phycisian 
D : Physician 

 
220  : Which of the following expresses 
congratulations? 
A : Well done, keep it up! 
B : See you, bye! 
C : Hello, everybody 
D : Good night! 

 
221  : Which option expresses appreciation? 
A : My goodness! 
B : My god! 
C : Ouch! 
D : Wow! 

 
222  : What is the maximum percentage of 
errors allowed for speed calculation and awarding 
marks? 
A : 10% 
B : 5% 
C : 2% 
D : 0% 

 
223  : What is the percentage of error 
admissible? 
A : 10% 
B : 2% 
C : 5% 
D : 1% 
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224  : What is the net speed of a passage of 300 
words, error committed is 15 for a 10 minutes 
passage?(error admissible 5%)? 
A : 28 wpm 
B : 27 wpm 
C : 30 wpm 
D : 29 wpm 

 
225  : Which currency represents this symbol 
(£)? 
A : American dollar 
B : Pound sterling 
C : Singapore dollar 
D : Chinese currency 

 
226  : What is the roman letter for 50? 
A : XXXXX 
B : XXXXL 
C : CX 
D : L 

 
227  : Which key buttons are not included in 
counting of gross speed? 
A : Enter key 
B : Arrow keys 

C : Number keys 
D : Shift and backspace keys 
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228  : How is N hook written to straight strokes? 
A : As a small final hook written with the right 
motion 
B : As a large final hook written with the left 
motion 
C : As a small final hook written with the left 
motion 
D : As a large final hook written with the right 
motion 

 
229  : When are final hooks employed? 
A : F/V hook is not written to stroke F/V 
B : F/V hook is employed when a vowel follows 
F/V 
C : N hook is not employed to strokes F/V 
D : N hook is employed when a vowel follows N 

 
230  : How is circle NS written to strokes? 
A : As a small initial circle to curved strokes 
B : As a small circle written inside N hook of 
curves 
C : As a small final circle written with the right 
motion to straight strokes 
D : As a small final circle written inside N hook of 
straight strokes 

 
231  : Which is incorrect? 
A : Shun hook is a small final hook 
B : Circle S can be added to shun hook 
C : Shun hook is a large final hook 
D : Shun hook is written inside all curves 

 
232  : Which words is Halving Principle not 
employed? 
A : Right, write, rot, wrote, writ 
B : Rabbit, rapid, credit, debit 
C : Paved, proved, greed, bread 
D : Plate, thought, brayed , grade 

 
233  : When is halving principle not employed? 
A : When diphthong immediately precedes T/D 
B : When a diphone immediately precedes T/D 
C : When a triphone immediately precedes T/D 
D : When T/D is not followed by a final vowel 

 
234  : Which sentence is correct? 
A : He went to a stationary shop to buy paper 

B : The auto hit a stationery lorry 
C : The sun is stationary unlike the planets 
D : How can you purchase grocery items from a 
stationary shop? 

 
235  : Which sentence is correct? 
A : I compliment your wife for the excellent meal 
B : I complement you on your handling of this 
difficult situation 
C : The music compliments her voice perfectly 
D : The newspaper uses photos to compliment 
the news story 

 
236  : Which sentence uses the word 
‘principal’/’principle’ correctly? 
A : The country is run on socialist principals 
B : It is difficult to put our principals into practice 
C : The Government is upholding the principles 
of democracy 
D : He is the principle of this great institution 

 
237  : Which sentence is correct? 
A : Members are elected to Tiruverkadu town 
counsel every three years 
B : Dr.Radha was elected to the State Legislative 
Council 
C : His council on domestic relations is sound 
D : Do not give council unless asked for 

 
238  : Which sentence is correct? 
A : I sent a gift to my friend on the occasion of 
his marriage 
B : The atmosphere is filled with the cent of 
roses 
C : He obtained sent per sent marks in 
Mathematics 
D : I received a box full of sent bottles 
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239  : When can a straight stroke be doubled? 
A : When it follows a stroke consonant 
B : When it precedes a stroke consonant 
C : When it has a final disjoined diphthong 
D : When it has no final hook 

 
240  : Which word cannot be written using 
doubling principle? 
A : Doubter 
B : Wonder 
C : Daughter 
D : Scooter 

 
241  : When do you double the stroke MP/MB? 
A : When it is hooked initially 
B : When it is hooked finally 
C : When it is not hooked 
D : It cannot be doubled at all 

 
242  : When is doubling principle not employed? 
A : When circle S occurs after -tr, -dr, etc. 
B : To represent the heavy sound of ‘thr’ 
C : When a vowel follows final –tr, -dr, etc. 
D : When a vowel does not follow final –tr, -dr, 
etc. 

 
243  : When is hooked form of MPR/MBR used? 
A : After a straight upstroke 
B : After a curved upstroke 
C : After any upstroke and K 
D : After stroke K 

 
244  : When is double-length form of NG-KR/NG-
GR not used? 
A : After a downstroke 
B : Initially 
C : After initial circle S 
D : After an upstroke 

 
245  : Which word substitutes the group of 
words “ One who loves his country”? 
A : Aristocrat 
B : Patriot 
C : Martyr 
D : Traitor 

 
246  : Which word substitutes the group of 
words “ One who looks at the cheerful side of 
things”? 
A : Pessimist 

B : Philanthropist 
C : Misogynist 
D : Optimist 

 
247  : Which word substitutes the group of 
words “A Government by the people”? 
A : Aristocracy 
B : Autocracy 
C : Consortium 
D : Democracy 
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248  : Which word cannot be written using con-
/com- dot? 
A : Committee 
B : Consul 
C : Compel 
D : Congratulate

249  : How is prefix ‘self-‘ represented? 
A : By a circle in the first place before a stroke 
B : By a circle in the first place after a stroke 
C : By a circle in the second place after a stroke 
D : By a circle in the second place before a stroke

250  : Which word fully expresses the 
termination - arity? 
A : Popularity 
B : Barbarity 
C : Regularity 
D : Disparity

251  : Which is correct with regard to suffix –
ment? 
A : -nt is disjoined and written 
B : The contracted form of –mnt is –nt 
C : In the word ‘refinement’, -mnt is used 
D : -ment is written if –nt is inconvenient to 
write

 
252  : Which word meaning is ʹstaffʹ if spelt 
correctly? 
A : Personal 
B : Personel 
C : Personnal 
D : Personnel 

 
253  : Which is the word with correct spelling? 
A : Suspicious 
B : Suspecious 
C : Suspitious 
D : Suspishus 

 
254  : Which word is spelt correctly? 
A : Physition 
B : Physician 
C : Phycisian 
D : Physision 

 
255  : Which of the following expresses 
congratulations? 
A : Hello, everybody 

B : Good night 
C : Very good 
D : Well done, keep it up 

 
256  : Which expression should not be used for 
elders? 
A : Hello 
B : Hi 
C : Good morning 
D : Good night 

 
257  : Which expressions are used to make 
requests? 
A : Iʹd like to have… 
B : Iʹam crazy 
C : Would you mind… 
D : Iʹhad rather have 

 
258  : Which option expresses appreciation? 
A : My goodness! 
B : My God 
C : Ouch! 
D : Wow! 

 
259  : What will be your negative response to 
ʺhello, may I help youʺ? 
A : Donʹt worry 
B : That is really very kind of you 
C : Itʹll be a pleasure if you help me 
D : Mm…I wonʹt say no to it. 

 
260  : When asked for opinion, what would be 
your positive response? 
A : No comments please 
B : Itʹs puzzling 
C : Yes, it is terrific 
D : I donʹt know what to say 

 
261  : When asked for permission, how would 
you respond positively? 
A : Iʹam afraid, you canʹt 
B : Of course, you can 
C : Not at all 
D : Sorry, Iʹam going to need it. 
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262  : Which figures are represented in 
shorthand? 
A : Figures 1 to 7 and 9 
B : Figure 8 
C : Figure 23 
D : 75 

 
263  : When is medial ‘t’ omitted? 
A : When medial ‘t’ immediately follows circle S 
B : When medial ‘t’ immediately precedes circle 
S 
C : When medial ‘t’ immediately follows large 
circle 
D : When medial ‘t’ immediately precedes large 
circle 

 
264  : How are general contractions formed? 
A : By medial omission of consonant 
B : By final omission of consonant 
C : By final omission of syllable 
D : By medial or final omission of consonant or 
syllable 

 
265  : How are vowels and position of 
contractions indicated? 
A : Contractions are generally written on the line 
B : Contractions are never written on the line 
C : Contractions are written through the line 
D : Contractions are written above the line 

 
266  : Why we should use essential vowels? 
A : Identity the word 
B : Identify stroke 
C : Identity the correct word 
D : To know the meaning of the word 

 
267  : Which is the most appropriate answer on 
how a letter should be typed? 
A : With accuracy and in proper format 
B : Leaving 10 degrees right margin 
C : Leaving equal top and bottom margins 
D : Without punctuation marks and 
capitalization 

 
268  : Which is correct with regard to personal 
letters? 
A : Salutation begins with ‘Dear..’ 
B : Complimentary close is ‘Yours 
sincerely’/’Yours truly’ 

C : Date is written at the bottom of the letter 
D : Contents of the letter should be to the point 

 
269  : Which subscription is correctly punctuated 
and capitalized? 
A : Your’s faithfully, 
B : Yours Faithfully 
C : Yours Faithfully, 
D : Yours faithfully, 

 
270  : Which option is true of Demi-official 
letters? 
A : Salutation is ‘Dear Mr.....’ 
B : Salutation is ‘Dear Sir/Dear Madam’ 
C : Complimentary close is ‘Yours truly’ 
D : Receiver’s address is above salutation 
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271  : What is the advantage of unvocalized 
outlines? 
A : They help to write fast 
B : They always help to read correctly 
C : They need not be written in position 
D : They do not save time 

 
272  : Which is the correct method of practising 
Shorthand outlines? 
A : Practising at irregular intervals 
B : Practising three hours a day every week 
C : Practising two hours every alternate day 
D : Practising an hour a day 

 
273  : Which is correct? 
A : The pen should be held with light pressure 
B : The whole hand should be held tight on the 
little finger 
C : Sprawling outlines improve speed 
D : A few omissions are better than risking 
legibility of outlines 

 
274  : What is to be done if a wrong outline is 
written during speed writing? 
A : Erase the outline and rewrite it 
B : Leave the outline as it is 
C : Circle the outline and rewrite it 
D : Make a mark in the margin 

 
275  : Which are the three elements to be 
trained for speed writing? 
A : Note book, pencil and eraser 
B : Shorthand pen, lined paper and eraser 
C : Sitting posture, eyesight and hand 
D : Brain, hand and eyesight 

 
276  : Which is NOT required for transcription? 
A : Knowledge of local language 
B : Concentration 
C : Good typing speed 
D : Alertness 

 
277  : Which one is the great hindrance in speed 
writing? 
A : Silent atmosphere 
B : Proper ventilation 
C : Use of vowels 
D : Shorthand pencil 

 

278  : What is the first step to be done after 
transcription? 
A : Take a break 
B : Read it loudly 
C : Keep it in the concerned file 
D : Compare with notes to detect omissions 

 
279  : How should notes be taken? 
A : Notes are taken on both sides of the book 
B : Notes are not written till the end of the page 
C : Notes are written on one side of the book 
D : Notes are written on alternate lines 

 
280  : How and when should the leaf be turned 
over? 
A : It should be shifted by degrees and turned 
over at a convenient moment 
B : It should be shifted rapidly and turned over 
at a convenient moment 
C : It should be turned over after writing on the 
upper half 
D : It should be turned over after writing on the 
lower half 

 
281  : Which slows down your speed of note-
taking? 
A : Using phraseograms 
B : Employing vocalized outlines 
C : Using contractions 
D : Employing unvocalized outlines 

 
282  : What should be done to gain speed in 
note-taking? 
A : All vowels should be inserted 
B : Unnecessary vowels should be omitted 
C : Strokes should be exaggerated in size 
D : Wrong outlines should be corrected at once 

 
283  : Which will come to your aid in note-
taking? 
A : Spelling of words 
B : Grammar of language 
C : Vocabulary of words 
D : Spelling, grammar and meaning of words 
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ANSWERS : 

 
1:B; 2:C; 3:B; 4:D; 5:B; 6:D; 7:A; 8:C; 9:B; 10:B; 11:B; 
12:A; 13:C; 14:A; 15:D; 16:B; 17:C; 18:B; 19:B; 20:B; 
21:B; 22:C; 23:A; 24:B; 25:C; 26:D; 27:B; 28:C; 29:D; 
30:C; 31:C; 32:D; 33:A; 34:C; 35:B; 36:A; 37:C; 38:B; 
39:B; 40:B; 41:C; 42:D; 43:D; 44:C; 45:C; 46:D; 47:B; 
48:C; 49:D; 50:B; 51:A; 52:C; 53:C; 54:A; 55:B; 56:B; 
57:A; 58:C; 59:C; 60:B; 61:A; 62:D; 63:B; 64:C; 65:B; 
66:C; 67:C; 68:A; 69:A; 70:B; 71:D; 72:A; 73:C; 74:B; 
75:D; 76:C; 77:D; 78:D; 79:B; 80:C; 81:A; 82:A; 83:B; 
84:A; 85:C; 86:A; 87:B; 88:B; 89:A; 90:C; 91:B; 92:C; 
93:B; 94:C; 95:B; 96:C; 97:D; 98:D; 99:C; 100:C; 
101:D; 102:C; 103:C; 104:B; 105:C; 106:B; 107:B; 
108:A; 109:A; 110:D; 111:D; 112:C; 113:C; 114:B; 
115:D; 116:D; 117:C; 118:B; 119:A; 120:C; 121:D; 
122:D; 123:C; 124:A; 125:C; 126:D; 127:A; 128:B; 
129:C; 130:C; 131:D; 132:C; 133:B; 134:B; 135:B; 
136:C; 137:B; 138:B; 139:C; 140:C; 141:A; 142:D; 
143:C; 144:D; 145:B; 146:A; 147:A; 148:C; 149:D; 
150:A; 151:C; 152:A; 153:A; 154:D; 155:B; 156:C; 
157:B; 158:B; 159:D; 160:D; 161:A; 162:B; 163:D; 
164:C; 165:C; 166:B; 167:B; 168:A; 169:B; 170:B; 
171:B; 172:B; 173:D; 174:B; 175:A; 176:D; 177:C; 
178:D; 179:B; 180:D; 181:D; 182:C; 183:C; 184:D; 
185:B; 186:B; 187:A; 188:B; 189:B; 190:D; 191:B; 
192:A; 193:C; 194:C; 195:D; 196:B; 197:C; 198:D; 
199:D; 200:C; 201:C; 202:B; 203:D; 204:B; 205:A; 
206:D; 207:C; 208:D; 209:C; 210:D; 211:C; 212:D; 
213:B; 214:B; 215:C; 216:C; 217:B; 218:D; 219:D; 
220:A; 221:D; 222:B; 223:C; 224:C; 225:B; 226:D; 
227:D; 228:A; 229:A; 230:C; 231:A; 232:A; 233:C; 
234:C; 235:A; 236:C; 237:B; 238:A; 239:A; 240:C; 
241:C; 242:C; 243:C; 244:A; 245:B; 246:D; 247:D; 
248:B; 249:D; 250:D; 251:B; 252:D; 253:A; 254:B; 
255:D; 256:B; 257:C; 258:D; 259:A; 260:C; 261:B; 
262:A; 263:A; 264:D; 265:A; 266:C; 267:A; 268:A; 
269:D; 270:A; 271:A; 272:D; 273:D; 274:C; 275:D; 
276:A; 277:C; 278:D; 279:C; 280:A; 281:B; 282:B; 
283:D; 
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1  : What is MS Excel? 
A : An electronic spreadsheet program 
B : An electronic calculating program only 
C : An electronic data program only 
D : An electronic Chart creating program only 

 
2  :  How columns in MS Excel are named? 
A : b) numbers (1,2,3,4,...) 
B : alphabets (A, B, C, D,...) 
C : Roman numerals (I,II, III, IV,...) 
D : Number and alphabets 

 
3  :  How rows in MS Excel are named? 
A : alphabets (A, B, C, D,...) 
B : (c) roman numerals (I,II, III, IV,...) 
C : numbers (1,2,3,4,...) 
D : Alphabets and roman numerals 

 
4  : What is called intersection of a row and 
column in MS Excel? 
A : Spreadsheet 
B : Workbook 
C : Document 
D : Cell 

 
5  : How to name a cell in column number 3 and 
row number 6? 
A : F3 
B : C6 
C : C3 
D : F6 

 
6  : What is the default setting of print in MS 
Excel? 
A : Landscape 
B : Automatic 
C : Fit to size 
D : Portrait 

 
7  : How many columns are there in the latest 
version of MS Excel? 
A : 10,48,576 
B : 16384 
C : 1024 
D : 512 

 
8  : How many rows are there in the latest 
version of MS Excel? 
A : 10,48,576 
B : 16384 

C : 1024 
D : 512 

 
9  : What is the basic unit for storing data? 
A : Column 
B : Rows 
C : Worksheet 
D : Cell 

 
10  : How many character can hold in a cell? 
A : Only one 
B : 32767 
C : Two only 
D : Three only 

 
11  : What will be known as the number of 
column increased to 16,384 In Excel 2010? 
A : XLD 
B : XFD 
C : XMD 
D : XVD 

 
12  : What is the maximum characters can be 
used to rename a worksheet? 
A : 21 
B : 23 
C : 31 
D : 32 

 
13  : What is the name of files created by a 
spreadsheet package? 
A : Work book 
B : Worksheet 
C : MS Excel 
D : Excel sheet 

 
14  : What is the formula used in United States 
to enter a date? 
A : Day/month/year 
B : Year/day/month 
C : Month/day/year 
D : Day/month/year 

 
15  : Where you can find the active cell in MS 
Excel? 
A : In the formula bar 
B : In the task bar 
C : In the spreadsheet 
D : In the workbook 

 



Stenographer and Secretarial Assistant– Semester 2 Module 1 - Introduction to MS 
Excel and Shorthand 

Reviewed and updated on: 01st November 2019 Version 1.1 
 

 NIMI Question Bank  Page 2 of 25 

16  : What is the shortcut key to get A1 active 
cell in In MS Excel? 
A : Ctrl + A 
B : Ctrl + C 
C : Ctrl + Home 
D : Ctrl + F 

 
18  : How worksheets are named by default? 
A : book1, book2, book3,... 
B : sheet1, sheet2, sheet3,… 
C : page1, page2, page3, … 
D : note1, note2, note3, … 

 
19  : How many build in calculations are almost 
included in MS Excel? 
A : 500 
B :    300 
C :    400 
D : 403 

 
20  : What is the name of common type of data 
applicable to any cell In MS Excel? 
A : General 
B : Number 
C : Currency 
D : Text 

 
21  : Which data type takes between 0 and 1 and 
displays them in percentage format? 
A : Date 
B : Time 
C : Percentage 
D : Fraction 

 
22  : What is called when copying and pasting an 
excel formula, to progressively update cell 
references? 
A : Static 
B : Semi-relative 
C : Relative 
D : Absolute 

 
23  : Which functions in MS Excel help access 
interest calculation, accounting and currency 
related calculations? 
A : Cube/ Database 
B : Date/ Time 
C : Engineering 
D : Financial 

 

24  : Which category In MS Excel, statistical 
functions like average, standard deviation, median, 
mode, etc. included? 
A : Lookup and reference 
B : Math and Trigonometric 
C : Statistical 
D : Logical 

 
25  : Which function returns the lower case 
version of given string in MS Excel? 
A : Upper 
B : Lower 
C : Proper 
D : Len 

 
26  : Which function In MS Excel, returns the first 
letter capitalized version 
of given string? 
A : Upper 
B : Lower 
C : Proper 
D : Len 

 
27  : What is to be selected to sort data in MS 
Excel? 
A : All the cells 
B : Just the column 
C : Just one row 
D : Only one cell 

 
28  : Which chart is used to compare the 
percentage of the sum that several numbers 
represents? 
A : Bar Chart 
B : Line chart 
C : Pie chart 
D : Column chart 

 
29  : Which is the graphical representation of 
data entered in the worksheet? 
A : Tables 
B : Tool bars 
C : Title bar 
D : Chart 
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30  : Which chart consists series of vertical bars 
in MS Excel? 
A : Pie chart 
B : Bar chart 
C : Column chart 
D : Line chart 

 
31  : Which chart shows the trends over time in 
MS Excel? 
A : Pie chart 
B : Line chart 
C : Bar chart 
D : Column chart 

 
32  : What is called a paper with rows and 
columns in which one can enter data 
which may be text or number in MS Excel? 
A : Data sheet 
B : Balance sheet 
C : Spread sheet 
D : Program sheet 

 
33  : Which bar contains the name box at the left 
end which will display the active cell address in MS 
Excel? 
A : Title bar 
B : Status bar 
C : Formula bar 
D : Menu bar 

 
34  : What contains the messages and prompts 
in MS Excel? 
A : Status bar 
B : Title bar 
C : Formula bar 
D : Menu bar 

 
35  : What is the extension given by MS Excel 
when a workbook is saved? 
A : .txt 
B : .ppt 
C : .xls 
D : .doc 

 
36  : What is the backbone of advanced 
calculations in MS excel? 
A : Cell 
B : Columns 
C : Formulas 
D : Rows 

 
37  : What excel understands when you enter 
=(equal) sign? 
A : A text is being given 
B : A formula is given to calculate 
C : A chart is being given 
D : Enter the text in Formula bar 

 
38  : What is the meaning of this sign in 
mathematical term in MS Excel 
( * )? 
A : Multiplication 
B : Division 
C : Adding 
D : Subtract 

 
39  : What is the cell reference that adjusts and 
changes when copied? 
A : Absolute 
B : Relative 
C : Radians 
D : Tangent 

 
40  : Where you can find custom tab option? 
A : Drop down dialog box of margin in page set 
up 
B : Home tab 
C : Insert tab 
D : References tab 

 
41  : What is the chief function of an office? 
A : Storing information 
B : Preparing and paying salaries 
C : Providing internal communication 
D : Making, using and preserving information 

 
42  : Which department takes care of the 
welfare of the employees? 
A : Finance Department 
B : Accounts Department 
C : Excise Department 
D : Personnel Department 

 
43  : Which department deals with taxes 
imposed on manufacture or sale of goods? 
A : Production Department 
B : Excise Department 
C : Export or Import Department 
D : Sales Department 
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44  : Which is true of an office? 
A : To prepare records for planning 
B : To prepare records for the purpose of control 
C : To prepare and preserve records for efficient 
management 
D : To prepare records for communication 

 
45  : Why is an office called ‘Data Bank’? 
A : It provides information and figures of the 
past 
B : It provides information and figures of the 
present 
C : It provides figures of the past and the present 
D : It provides information and figures of past 
and present 

 
46  : How do communications move in an office? 
A : Written communications move from top to 
bottom 
B : Written and oral communications move from 
top to bottom and vice versa 
C : Oral communications move from bottom to 
top 
D : Written communications move from bottom 
to top 

 
47  : Why are managerial controls important to 
an office? 
A : They serve to get rid of non-performing 
personnel 
B : They motivate the subordinates 
C : They measure and correct the performance 
of subordinates 
D : They infuse a sense of fear in the 
subordinates 

 
48  : Why should an office manager exercise 
control over his staff? 
A : To get performance according to standards 
fixed 
B : To detect drawbacks in the staff 
C : To weed out substandard staff 
D : To discourage under-performers 

 
49  : Which quality do you think will help a 
manager to succeed more than the others? 
A : Proficiency in English 
B : Ability to take decisions promptly and boldly 
C : Kind-hearted and friendly nature 
D : Knowledge about office machines 

 
50  : Which quality makes one a bad manager? 
A : Honesty 
B : Mental alertness 
C : Rigidity 
D : Self-control 

 
51  : What is called the process that initiates, 
guides, and maintains goal-oriented 
behaviour? 
A : Goal 
B : Achievement 
C : Motivation 
D : Result 

 
52  : What is called the process of stimulating 
people to actions to achieve goals? 
A : Promotion 
B : Achievement 
C : Motivation 
D : Goal 

 
53  : What improves the team spirit of the 
employees? 
A : Sports activities 
B : Better canteen facilities 
C : Better transport facilities 
D : Motivation 

 
54  : What helps to reduce labour grievances and 
disputes? 
A : Labour laws 
B : Government agencies 
C : Cordial relations 
D : Lockouts 

 
55  : How the process of motivation starts in an 
individual? 
A : Greed of an individual 
B : Need of an individual 
C : Fear of an individual 
D : Failure of an individual 

 
56  : What basis the goals are selected in the 
process of motivation? 
A : Identifying needs 
B : Verifying needs 
C : Immediate needs 
D : Future needs 
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57  : What motivates an employee to perform 
improved level of performance? 
A : Punishment 
B : Agreement 
C : Rewards 
D : Promises 
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58  : Which safety measure should be given 
topmost priority? 
A : Avoiding polishing of floors as to make them 
slippery 
B : Providing First-Aid Box, fire extinguishers 
C : Providing ladders to reach high shelves 
D : Checking telephone wires from trailing 

 
59  : What is a good office layout? 
A : Keeping costs to a minimum 
B : Maximum utilisation of space 
C : Minimum utilisation of space 
D : Maximum utilisation of furniture 

 
60  : What is the advantage of good office 
environment to the business concern? 
A : Increase in production 
B : Ease in work 
C : Improvement in mental health 
D : Increase in employees’ absenteeism 

 
61  : Why is interior decoration of office space 
important? 
A : Employees work at a slow pace 
B : Employees develop the capacity to work very 
fast 
C : Employees enjoy working hard for long hours 
D : Employees work by fits and starts 

 
62  : Which type of furniture is most desirable 
for an office? 
A : Furniture which is comfortable to work with 
B : Furniture which is comfortable as well as eye-
catching 
C : Furniture which is artistically designed 
D : Furniture with good looks 

 
63  : Which is correct about interior colouring? 
A : Walls of the office should be in dark colour 
B : Walls of the office should be in light colour 
C : There should be sharp contrast in colours 
D : Orange, yellow and brown colours bring 
indifferent feelings 

 
64  : Which is correct with regard to security 
arrangements for office? 
A : First-Aid Box should be installed for every 
1,000 workers 
B : Fire Alarm should be tested from time to 
time 

C : Fire extinguisher should be in charge of one 
person 
D : Untrained staff can render first aid in case of 
emergency 

 
65  : What is your understanding of office 
layout? 
A : Arrangement of different departments in the 
space available 
B : Arrangement of different equipment in the 
space available 
C : Arrangement of personnel in the space 
available 
D : Arrangement of personnel and equipment 
for maximum effectiveness and co-ordination 

 
66  : Which symbol is to be entered first for a 
function in MS excel? 
A : @ 
B :  $ 
C :  # 
D : = 

 
67  : How to get format cell option? 
A : Click formula bar in Excel sheet 
B : Click insert tab in Excel sheet 
C : Click Page Layout tab in Excel sheet 
D : Right click cell in Excel sheet 

 
68  : What is the shortcut key for changing Font 
size in Excel sheet? 
A : Ctrl + F 
B : Ctrl + 1 
C : Alt + 1 
D : Shift + Alt + 1 

 
69  : What is the option to get double underline 
the text in a cell? 
A : Select text and underline two times 
B : Draw manually using = sign 
C : Select text → select double line from Home 
tab 
D : Select text → Home tab→Font→Click near U 
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70  : What are the steps for rotating a cell? 
A : Right click the cell and use options 
B : Format cells>alignment 
C : Right click cell>Format >Alignment>set 
degree for rotation 
D : Insert tab> text>Alignment>set degree 

 
71  : What is the step to get the background 
colour option in MS excel? 
A : Home>Style group 
B : Insert> Font group>background colour 
C : Page Layout> Font group 
D : Home>Font group > background colour 

 
72  : Where will align the text in a cell in MS 
Excel by default? 
A : Right of the cell 
B : Top of the cell 
C : Bottom of the cell 
D : Left of the cell 

 
73  : Where will align the numbers in a cell in 
Excel by default? 
A : Left of the cell 
B : Top of the cell 
C : Right of the cell 
D : Bottom of the cell 

 
74  : What are the vertical alignments options in 
MS excel? 
A : Top, Bottom, Centre, Horizontal 
B : Top, Centre, Vertical, Justify 
C : Bottom, Top, Centre, Justify 
D : Justify, Top, Bottom and Fill 

 
75  : What is the space occupied by merged 
cells? 
A : Double the merged cells 
B : Three times of the merged cells 
C : Half of the merged cells 
D : Same space of the merged cells 

 
76  : What is the command for multiple merged 
cells? 
A : Merge all 
B : Merge multiple 
C : Merge Across 
D : Cell Merge 

 

77  : What is the option available to fit the text 
in the same column? 
A : Wrap text option 
B : Fit to text option 
C : Wrap Column option 
D : Wrap and fit option 

 
78  : What you mean by shrink to fit option in 
MS Excel ? 
A : The text entered is in the same row 
B : The font of the text is automatically changes 
C : The column width is increased 
D : The text remains in the same column 

 
79  : What was the standard amount of column 
up to Excel 2003? 
A : 65536 
B : 625 
C : 256 
D : 526 

 
80  : What is code for the 256th column in Excel 
2003? 
A : BA 
B : BB 
C : DC 
D : IV 

 
81  : What function is used to calculate change in 
interest rate etc in Excel? 
A : Function Arguments 
B : Count if 
C : Sum if 
D : What if 

 
82  : What is called In excel sorting data in 
ascending or descending order? 
A : Count data 
B : Rearrange data 
C : Organise data 
D : Analysing data 

 
83  : What is called creating charts based on 
worksheet data? 
A : Summarize data 
B : Represent graphic designs 
C : Represent values graphically 
D :    Display charts 
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84  : What is called In MS Excel adding list of 
students appeared for examination and finding final 
results? 
A : Formula functions 
B : Performance calculation 
C : Data manipulation 
D : Auto filters 

 
85  : How to make a cell active in MS Excel? 
A : Click worksheet column 
B : Click worksheet row 
C : Click a cell 
D : Click formula bar 
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86  : When is recording of received letters done 
and In which order? 
A : After opening, sorting, scrutiny and stamping 
B : After sorting, opening, scrutiny and stamping 
C : After opening, scrutiny, sorting and stamping 
D : After opening, sorting, scrutiny and stamping 

 
87  : What details does stamping display? 
A : Receipt number 
B : Date and time of receipt 
C : Date and signature of receiver 
D : Number, date, time and signature 

 
88  : What is a franking machine? 
A : It imprints postage stamps on all types of 
letters 
B : It stamps the date and time of the letter 
received 
C : It automatically folds letters 
D : It opens letters accurately and speedily 

 
89  : Which option lists office supplies? 
A : Toner cartridges, markers, pens 
B : TVs, Air-conditioning units 
C : Label markers, modems 
D : Wi-fi routers, ports 

 
90  : Which is the most important use of office 
manuals? 
A : To get the work done in quick time 
B : To eliminate repetition of instructions and for 
standardization 
C : To fix responsibility for wrong 
implementation of rules 
D : To provide training to employees, old and 
new 

 
91  : How is mail received by big business houses 
safely? 
A : By hiring a post office bag 
B : By hiring post box and Post office bag 
C : From the postman of the area 
D : By hiring a post box 

 
92  : What is a mail? 
A : A handwritten communication sent 
B : A handwritten communication received 
C : A printed or written communication sent or 
received 
D : A printed communication received 

 
93  : What is true of office forms? 
A : It is a printed piece of paper 
B : User of office form cannot fill it 
C : No blank spaces are left in the forms 
D : It is a written piece of paper 

 
94  : Which is correct? 
A : Thin sheets of paper are used for typing 
reports 
B : Paper is the centre of action in an office 
C : Office manuals increase cost of operations 
D : Invoices do not come under office forms 

 
95  : What does scrutiny of letters calls for? 
A : Examination of contents 
B : Examination of enclosures 
C : Examination of contents and enclosures 
D : Examination of contents, enclosures and 
reporting of irregularities 

 
96  : What is computer virus? 
A : A system software 
B : A program 
C : A malicious software 
D : An inbuilt program 

 
97  : What is the term used when virus entered 
in a document? 
A : Affected 
B : Infected 
C : Effected 
D : Accepted 

 
98  : How viruses enter your computer? 
A : By opening program files 
B : By opening word file 
C : By opening unknown attachment in your 
email 
D : By opening the programme wrongly 

 
99  : What is called when a malicious server 
posing as an authentic server? 
A : Spoofing 
B : Phishing 
C : Bitnet 
D : Distributed Denial of Service 
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100  : What is called a malicious email or SMS 
communication inviting the user to click a link and 
take the user to a malicious web site? 
A : Spoofing 
B : Phishing 
C : Bitnet 
D : Distributed Denial of Service 

 
101  : What is called an intrusive login to a 
protected system from a remote system to carry 
out malicious acts? 
A : Hacking 
B : Malware 
C : Pharming 
D : Ransomeware 

 
102  : What is called a piece of software 
designed for ill intentions (virus), to steal user id/ 
password (trojan), erase data on computer 
(virus),etc? 
A : Hacking 
B : Malware 
C : Pharming 
D : Ransomeware 

 
103  : What is the term used when a piece of 
malware which spreads through attachments to 
emails?. 
A : Worm 
B : Spam 
C : Spyware 
D : Trojan 

 
104  : What piece of malware which keeps 
sending junk message advertising? 
A : Worm 
B : Spam 
C : Spyware 
D : Trojan 

 
105  : What is called that simply records 
computer activities and transmits them to a 
malicious site? 
A : Worm 
B : Spam 
C : Spyware 
D : Trojan 

 
106  : Which process allows you to identify 
viruses in a computing device? 

A : Editing 
B : Formatting 
C : Scanning 
D : Security 

 
107  : What type of motivation is the drive to 
pursue and attain goals? 
A : Competence motivation 
B : Achievement motivation 
C : Affiliation motivation 
D : Attitude motivation 

 
108  : What type of motivation drives to relate 
to people on a social basis? 
A : Affiliation motivation 
B : Incentive motivation 
C : Achievement motivation 
D : Competence motivation 

 
109  : Which type of motivation allows the 
individual to perform high quality work? 
A : Incentive motivation 
B : Power motivation 
C : Competence motivation 
D : Attitude motivation 

 
110  : What type of motivation drives to 
influence people and change situation? 
A : Fear motivation 
B : Incentive motivation 
C : Achievement motivation 
D : Power motivation 

 
111  : What type of motivation drives people 
think and feel their attitude to life? 
A : Fear motivation 
B : Incentive motivation 
C : Attitude motivation 
D : Competence motivation 

 
112  : Which type of motivation “you do this and 
you get that” slogan applies? 
A : Incentive motivation 
B : Achievement motivation 
C : Attitude motivation 
D : Affiliation motivation 
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113  : What kind of motivation is very popular in 
Indian Army? 
A : Power motivation 
B : Competence motivation 
C : Fear motivation 
D : Affiliation motivation 

 
114  : Which motivation is self applied? 
A : Extrinsic motivation 
B : Attitude motivation 
C : Intrinsic motivation 
D : Achievement motivation 

 
115  : Which type of motivation that refers to 
behaviour driven by external rewards? 
A : Extrinsic 
B : Intrinsic 
C : Self 
D : Compulsion 
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116  : Which tool in MS Office is used for 
preparation of presentations? 
A : MS Word 
B : MS Excel 
C : MS Access 
D : MS PowerPoint 

 
117  : What is the default extension for a 
presentation prepared in PowerPoint in MS Office 
version 2007 or later? 
A : .accdb 
B :  .pptx 
C : .xlsx 
D : .docx 

 
118  : Which tab allows you to get new slides in 
Power Point? 
A : Design >Themes 
B : Home >Font 
C : Home >New slides 
D : Home >Paragraph 

 
119  : Which combination of menus are to be 
used to get different shapes in Power Point 
presentation? 
A : Home >Drawing 
B : Home >Font 
C : Home >Slides 
D : Home >Paragraph 

 
120  : Which menu group align text option 
available? 
A : View > paragraph 
B : Home > paragraph 
C : Home > Fonts 
D : Home > editing 

 
121  : Which option is to be used to get images 
like picture from file, clipart and 
photo albums in Power Point? 
 
A : Insert >Tables 
B : Insert >Illustrations 
C : Insert >Links 
D : Insert >Images 

 
122  : Which menu opens this drop down 
window? 

 
A : Home 
B : Insert 
C : Format 
D : View 

 
123  : Which menu opens up this in the Ribbon 
in PPT? 

 
A : View 
B : Format 
C : Home 
D : Insert 

 
124  : Which menu open up this in the menu bar 
in PPT? 

 
A : Review 
B : View 
C :  Insert 
D : Home 
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125  : Which tab is to be click opened to get this 
menu in the menu bar in PPT? 

 
A : Insert 
B : Home 
C : Design 
D : Format 

 
126  : Which tab open this option in the menu 
bar in PPT? 

 
A : Slide Show 
B : Slide sorter 
C : Animations 
D : File menu 

 
127  : How to get this option in the menu bar in 
PPT? 

 
A : Click open insert menu 
B : Click open format menu 
C :  Click open view menu 
D :  Click open review menu 

 
128  : Which menu opens this option in the 
menu bar in PPT? 

 
A : (a) Click open home tab 
B : (b) Click open Insert tab 
C : (c) Click open view tab 
D : (d) Click open Review tab 

 
129  : Where you can find current slide number 
in Power Point windows? 
A : Title bar at the top 
B : Status bar at the bottom 
C : Menu bar 
D : Tool bar 

 
130  : Where is zoom slider located? 
A : In the menu bar 
B : In the title bar 
C : In the status bar 
D : View menu 

 
131  : How to view the document at different 
percentage in PPT? 
A : View menu 
B : Home menu 
C : Review menu 
D : Use zoom slider 

 
132  : What divides the window in three working 
areas in Power Point program? 
A : Normal view 
B : Outline view 
C : Review 
D : Slide view 
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133  : Which menu option, In PowerPoint, slide 
transition effects may be controlled? 
A : Design >Themes 
B : Design >Effects 
C : Insert >Colours 
D : Insert >Fonts 

 
134  : Which option, in PowerPoint, slide theme 
can be controlled? 
A : Design > Background 
B : Insert >Colours 
C : Insert >Fonts 
D : Design >Themes 

 
135  : What is the option to get background fill 
colour, can be achieved? 
A : Design >Background 
B : Design >Themes 
C : Insert >Colours 
D : Insert >Fonts 

 
136  : What is filing? 
A : Safe keeping of documents received 
B : Storing of original documents 
C : Preservation of documents sent/received for 
ready reference 
D : Storing of copies of original documents sent 

 
137  : What is the disadvantage of geographical 
classification? 
A : Geographical knowledge a must 
B : Speedy location of files 
C : It is simple to adopt 
D : Direct filing is possible 

 
138  : Which is correct? 
A : Without filing, modern business can be run 
effectively 
B : Without filing, sales can be promoted 
C : Without filing, planning for future is possible 
D : Without filing, letters requiring immediate 
attention cannot be disposed of 

 
139  : Why is filing necessary? 
A : For locating original documents/records 
B : For systematic preservation of documents for 
future use 
C : For locating original records or copies of 
records 
D : For locating copies of letters sent 

 
140  : What is the essential characteristic of a 
good filing system? 
A : It should be easily located when needed for 
reference 
B : It should store miscellaneous files 
C : It can neither be expanded nor contracted 
D : It can occupy as much space as it requires 

 
141  : What do you mean by chronological filing? 
A : In this system, files are kept in numerical 
order 
B : In this system, files are grouped on the basis 
of state 
C : In this system, files are maintained in order of 
time 
D : In this system, files are arranged on the basis 
of subjects 

 
142  : Which is true of alphabetical filing? 
A : Surname is written last in the case of 
individual 
B : Separate indexing is necessary 
C : It cannot be expanded when needed 
D : Records are kept in alphabetical order 

 
143  : What is the disadvantage of alphabetical 
classification? 
A : Locating papers in a large organization 
B : Re-arranging of guide cards with increase in 
records 
C : Sorting out misspelling of names 
D : Allotting space to each alphabet 

 
144  : Why is ‘compactness’ an essential 
characteristic of a good filing system? 
A : Because modern office space is costly 
B : Because modern office space is cheap 
C : Because in its absence, filing looks 
messy/untidy 
D : Because in its absence, filing looks neat 
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145  : Which is correct with regard to filing? 
A : The authorised staff alone should access the 
files 
B : The employees should be trained to file 
documents 
C : The filing equipment should not be cheap 
D : All the files should retained and never 
discarded 
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146  : What comes to your mind when you think 
of a decentralized filing system? 
A : Confusion as to where information can be 
found 
B : There will be no uniformity in filing 
C : Can result in fragmented documentation 
D : Does not require full-time staffing 

 
147  : What are the requirements of a good 
secretary? 
A : A speed of 100/40 words per minute in 
shorthand and typewriting 
B : A speed of 80/30 words per minute in 
shorthand and typewriting 
C : A postgraduate degree in science 
D : A tendency to take every little problem to 
the boss 

 
148  : Which skill is required for one to make a 
good secretary? 
A : Good written communication 
B : Good written and verbal communication 
C : Good verbal communication 
D : Ability to operate duplicator 

 
149  : Which quality should a secretary possess? 
A : Giving in to emotions on provocation 
B : Being courteous to superiors only 
C : Passing embarrassing comments 
D : Remaining cool under all circumstances 

 
150  : How can maintaining good personal 
relationships help a private secretary? 
A : He can extract little work from the 
employees 
B : He can get more work done from the 
employees 
C : He can get good support from his employer 
D : He can get many admirers from his 
employees 

 
151  : What are the duties of a secretary in 
organizing meetings? 
A : Preparing agenda of the meeting 
B : Preparing minutes of the meeting 
C : Expressing vote of thanks to members 
D : Preparing agenda and minutes and 
expressing vote of thanks 

 

152  : What are the duties of secretary general? 
A : To conduct business of the state legislatures 
B : To discharge duties to a cabinet secretary 
C : To conduct business in the Lok Sabha/Rajya 
Sabha 
D : To conduct business in the house and 
Parliamentary committees 

 
153  : Which option is correct for a private 
secretary? 
A : He performs the work of a Stenographer 
B : He performs the work of an Assistant 
C : He performs the work of Stenographer and 
Assistant 
D : His relationship with officer is of master and 
servant 

 
154  : Which secretary is elected? 
A : Private secretary 
B : Secretary of co-operative Society 
C : Company secretary 
D : Secretary of embassy 

 
155  : Which of the secretaries acts as a pivot 
between shareholders and the management? 
A : Secretary of a Club or Association 
B : Secretary of a Local Body 
C : Company secretary 
D : Secretary of co-operative society 

 
156  : Which skill is not a pre-requisite for a 
secretary? 
A : Good organisational skills 
B : Good communication skill, written and verbal 
C : Good time management 
D : Knowledge of stencilling and duplicating 

 
157  : How can a secretary get more work done 
from the employees? 
A : By employing tactfulness 
B : By good personal relationship 
C : By not adopting to the nature of his 
employees 
D : By maintaining discipline 
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158  : What is the advantage of a centralized 
filing system? 
A : Records too distant from staff for adequate 
service 
B : Effective use of equipment, supplies and 
space 
C : Required full-time staffing 
D : Can result in increased filing systems 

 
159  : What is the disadvantage of a centralized 
filing system? 
A : All related data kept together 
B : Responsibility easily fixed 
C : Requires full-time staffing 
D : Uniform service provided to one and all 

 
160  : What is the advantage of a decentralized 
system of filing? 
A : Does not require full-time staffing 
B : Lack of uniformity or consistency 
C : Confusion as to where information can be 
found 
D : Can result in fragmented documentation 

 
161  : What is the option, In Power Point, 
presentation preview can be started? 
A : Transition >Transition to this slide 
B : Transition >Preview 
C : Timing 
D : Slide show 

 
162  : What is animation In Power Point? 
A : The movement of slides 
B : The movement of text and objects on the 
slide 
C : The appearance of the slide 
D : Time taken for movement of objects 

 
163  : What is transition in Power point 
presentation? 
A : The movement of objects in the slide 
B : The time taken by the objects to move 
C : The movement of the slide one by one 
D : Time taken by the slide to change 

 
164  : What menu helps to effect sound effects 
for slide transition, automatic-transition time, etc.,? 
A : Transition >Preview 
B : Transition >Transition to this slide 

C : Transition Rehearsal 
D : Transition >Timing 

 
165  : What is the option to display only selected 
slides? 
A : Slide show> start slide show 
B : Slide show> custom slide show 
C : Slide show > from current slide 
D : Slide show > from beginning 

 
166  : Which menu is to be used to set up slide 
show? 
A : Slide show >Start slide show 
B : Slide show >Set up 
C : Slide show > effects 
D : Slide show > custom slide show 

 
167  : Which menu in the ribbon you get arrange 
all option? 
A : Home 
B : Handout Master 
C : View 
D : Review 

 
168  : What should be done to get theme, zoom 
fit, zoom slider etc. in power point presentation? 
A : Click Home tab 
B : Right click status bar 
C : Click page layout 
D : Click insert menu 

 
169  : What will not be visible In graphic mode? 
A : Text 
B : Picture 
C : Title 
D : Cursor 

 
170  : How all elements are considered In power 
point ? 
A : Text 
B : Picture 
C : Graphic objects 
D : Figures 
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171  : What will be effected, place holder in text 
mode, by formatting changes? 
A : The border 
B : The cursor 
C : The selected text 
D : Entire place holder 

 
172  : When the cursor is moved over the 
graphic what happens to the cursor? 
A : The cursor disappears 
B : The shape of the cursor change to move 
mode 
C : The shape of the cursor becomes small 
D : The cursor stops moving 

 
173  : At the end of the slide show what appears 
on the computer screen? 
A : End show message appears 
B : Slid show automatically restarts from the first 
slide 
C : Black screen appears 
D : Computer goes off 

 
174  : Which part in the slide will not be 
displayed during presentation in power point? 
A : Slide number 
B : Slide title 
C : Headings 
D : Speakers notes 

 
175  : Which key in the keyboard will end the 
slide show at any time? 
A : Ctrl key 
B : Alt key 
C : Shift key 
D : Escape (Esc) key? 

 
176  : What is material management? 
A : Complete cycle of material flow for 
production 
B : Procurement of one item 
C : Supply to production chain 
D : Disposal of scrap items 

 
177  : Which one is not an activity of Materials 
Management? 
A : Planning 
B : Purchasing 
C : Storing 
D : Cash handling 

 
178  : What is the primary objective of material 
management? 
A : Maintain continued supply of material 
B : Maintain cash book 
C : Recruitment drive 
D : Frame rules and regulations 

 
179  : Who is in-charge of sale of finished goods? 
A : General Manager 
B : Materials manager 
C : Sales Manager 
D : Personnel Manager 
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180  : Which one is the domain name extensions 
for general public? 
A : .com 
B : .gov 
C : .mil 
D : nic 

 
181  : What does E-mail stand for? 
A : Economic mail 
B : Electric mail 
C : Electronic mail 
D : Express mail 

 
182  : Which one is E-mail default? 
A : Inbox 
B : Account holders photo 
C : Account holders phone number 
D : Account holders address 

 
183  : What is required to send an E-mail in 
addition to internet connected PC? 
A : MS Excel program 
B : Fax machine 
C : Landline phone 
D : E-mail Account 

 
184  : What is WWW stands for? 
A : World With Web 
B : World Wide Web 
C : Word With Web 
D : Whole World Web 

 
185  : What are the reserved domain name 
extensions for Government? 
A : .gov 
B : .mil 
C : .edu 
D : .in 

 
186  : What are the sequence to send an email? 
A : Log on email account 
B : Enter text 
C : Click compose 
D : Click send 

 
187  : Which search engine holds first place from 
among the list? 
A : Yahoo 
B : Mozilla Firefox 

C : Google 
D : Internet explorer 

 
188  : How to make payment for online ticket 
booking? 
A : Pay by cash 
B : Pay by cheque 
C : Pay by demand draft 
D : Make electronic payment 

 
189  : What is the process called that aims to 
review and identify threatening viruses and 
programs? 
A : Formatting 
B : Scanning 
C : Programming 
D : Surfing 

 
190  : Which icon/ arrow mark is used to forward 
an email from your inbox? 
 

 
A : Left arrow mark - A 
B : Dotted line-D 
C : Right Arrow mark – C 
D : Middle arrow mark - B 

 
191  : What is called the medium of sending and 
receiving messages using Internet? 
A : News 
B : Media 
C : Search Engine 
D : E-mail 
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192  : What is called connecting several 
computers and devices using wired or wireless 
technology? 
A : Hard disk 
B : RAM 
C : Pen drive 
D : Networking 

 
193  : How Internet is constituted? 
A : Network of networks 
B : Hard disk 
C : Search engines 
D : Mother board 

 
194  : What is called the computer which 
separates a local network from external Internet? 
A : Topology 
B : Protocol 
C : Firewall 
D : Antivirus 

 
195  : What is the name of a piece of software 
which prevents malicious software from entering a 
computer? 
A : Topology 
B : Protocol 
C : Firewall 
D : Antivirus 

 
196  : What uses most of the wired network 
connections? 
A : Optical Fibre Cable (OFC) 
B : USB cable 
C : Pen drive 
D : Hard drive 

 
197  : What technology is used for wireless 
network connections? 
A : Gateway 
B : Repeater 
C : Wireless Fidelity (WiFi) 
D : SMTP 

 
198  : What is MODEM stands for?. 
A : Modulation Deformation 
B : Modulation Demodulation 
C :  Modern Demodulation 
D :  Moderate Demodulation 

 

199  : What requires to connect important 
components each other? 
A : IP address 
B : Phone number 
C : Fax machine 
D : Printer 

 
200  : What is LAN stands for? 
A : Local Area Number 
B : Lead Area Network 
C : Lead Assignment Network 
D : Local Area Network 

 
201  : What is WAN stands for? . 
A : Wide Area Number 
B : Wide Assignment Network 
C : Wise Area Network 
D : Wide Area Network 

 
202  : What is the name of a computer that 
provides resources to other computers on a 
network? 
A :  LAN 
B :  WAN 
C :  Server 
D :  File sharing 

 
203  : Which type of network is advisable for the 
interprocessor distance of more than 1000 Km? 
A : Wide Area Network 
(WAN) 
B : Metropolitan Area Network (MAN) 
C : Local Area Network (LAN) 
D : Internet 

 
204  : What is HTTP stands for? 
A : Home page Text Transform Protocol 
B : Home page Text Transfer Protocol 
C : Hyper Text Transfer Protocol 
D : Hyper Text Transform Protocol 

 
205  : Which of the following office machines is 
most useful in an office? 
A : Copier that takes infinite copies 
B : Printer that prints many copies at a time 
C : Machine that combines the functions of 
printer, scanner, copier 
D : Scanner that converts matter into digital 
form 
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206  : What is the function of a scanner? 
A : Does not relay on computer to carry out its 
function 
B : Converts printed document into digital form 
C : Takes many copies at a time 
D : Prints large posters 

 
207  : How do you maintain office equipment? 
A : By changing the position of the equipment 
frequently 
B : By attending to paper jams belatedly 
C : By cleaning the machines regularly 
D : By cleaning he machines occasionally 

 
208  : What is the use of FAX machine? 
A : Sends documents electronically 
B : Receives documents electronically 
C : Sends and receives documents electronically 
D : Sends and receives documents without using 
telephone network 

 
209  : Which is correct for selecting the right 
machine? 
A : Should be cheap but long-lasting 
B : Should be substandard but not outdated 
C : Cost of operation should be minimum 
D : Cost of operation and maintenance should 
be minimum 

 
210  : Which is correct? 
A : Intercom cannot be used within a building 
B : Intercom functions independently of the 
public telephone network 
C : Duplicators have been replaced by more 
advanced printers 
D : Calculating and Billing machine is not a 
portable device 

 
211  : How do employment of office machines 
help an office? 
A : They save labour costs 
B : They ensure accuracy 
C : They promote speed 
D : They ensure speed, accuracy and uniformity 

 
212  : What factor should be borne in mind while 
selecting an office machine? 

A : Cost of operation should be minimum 
B : Cost of maintenance should be minimum 
C : Costs of operation and maintenance should 
be minimum 
D : Mode of operation should be simple 

 
213  : What is true of EPABX? 
A : It is a public Telephone Exchange 
B : It serves a particular business or office 
C : It serves many businesses 
D : It serves the general public 

 
214  : What is the expansion of EPABX? 
A : Electric Private Automatic Branch Exchange 
B : Electronic Private Automatic Branch 
Exchange 
C : Electronic Public Automatic Branch Exchange 
D : Electronic Principal Automatic Branch 
Exchange 

 
215  : A website that collects and organise 
content from all over the world is called……… 
A : Search engine 
B : Web 
C : Email 
D : Domain name 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 



Stenographer and Secretarial Assistant– Semester 2 Module 7 - Postal services 
Reviewed and updated on: 01st November 2019 Version 1.1 

 

 NIMI Question Bank  Page 22 of 25 

216  : Which is correct? 
A : India post transmits literature packets for 
blind for a fee 
B : Blind literature packets upto 10 kilograms are 
transmitted 
C : India post transmits free literature packets 
for blind 
D : Literature packets for blind should consist 
only periodicals 

 
217  : Which is true of courier services? 
A : Secure and speedy delivery 
B : No facility for tracking mail 
C : Managed by Government 
D : Charges on par with postal services 

 
218  : Which postal scheme can a child less than 
10 years of age invest in? 
A : Post Office Monthly Income Scheme 
B : Kisan Vikas Patra 
C : Sukanya Samriddhi Yojana 
D : Post Office Savings Account 

 
219  : Which post office scheme disallow 
deposits of more than Rs.15 lakh? 
A : NSC (National Savings Certificate) 
B : PPF (Public Provident Fund) 
C : SCSS (Senior Citizen Savings Scheme) and PPF 
D : SCSS (Senior Citizen Savings Scheme) 

 
220  : Which post office scheme caters to the 
welfare of the girl child? 
A : Post Office Monthly Income Scheme 
B : Sukanya Samriddhi Yojana 
C : Post Office Savings Account 
D : National Savings Certificate 

 
221  : Who can avail the Senior citizen savings 
scheme offered at post offices? 
A : Senior citizens of India above 60 years are 
eligible 
B : Any VRS (Voluntary Retirement Scheme) 
retiree is eligible 
C : Senior citizens of India above 58 years are 
eligible 
D : VRS retirees in the age group of 50-55 are 
eligible 

 
222  : What do you know of ‘Sukanya Samriddhi 
Yojana’? 
A : It is meant for handicapped children 
B : It is meant to secure the future of the boy 

child 
C : It meets girl child’s education and marriage 
expenses 
D : Initial amount required for opening account 
is Rs.100/- 

 
223  : What do you know of National Savings 
Certificate? 
A : It cannot be bought jointly 
B : It cannot be bought in the name of a minor 
C : Income Tax exemption up to 1.5 lakh 
available 
D : Maturity amount is not taxable 

 
224  : Which is true of Kisan Vikas Patra? 
A : It is meant for farmers only 
B : Income from KVP is not taxable 
C : Income doubles in 118 months 
D : Maximum limit of investment is ten lakh 
rupees 

 
225  : Which states and union territories are 
covered under postal number 6? 
A : Rajasthan, Gujarat, Daman and Diu 
B : Tamil Nadu, Kerala, Puducherry 
C : Andhra Pradesh, Karnataka, Telangana 
D : Goa, Maharashtra, Madhya Pradesh 

 
226  : When was the Postal Index Number (PIN) 
introduced? 
A : 15.08.1972 
B : 26.01.1972 
C : 02.10.1972 
D : 02.10.1975 

 
227  : Which is correct? 
A : Anything can be sent in a parcel 
B : If the parcel is rejected, it will not be 
returned to sender 
C : If the parcel is rejected, it will be returned to 
sender 
D : For registered newspapers, no concessional 
rates of postage are allowed 
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228  : Which is correct with regard to postal 
insurance? 
A : Insured value should exceed the value of the 
articles insured 
B : Insurance covers the risks during the course 
of transmission 
C : Gold and currency notes should not be 
insured for the actual 
D : Registered letters and registered parcels 
cannot be registered 

 
229  : What are the retail services offered by the 
post offices? 
A : Pays consumer bills of government 
organizations 
B : Pays bills of private organizations 
C : Pays bills of private and government 
organizations 
D : Reserves railway tickets in all its offices, big 
or small 

 
230  : Which is correct with regard to the 
facilities of Post box and Post bag offered by post 
offices? 
A : Facilities are free 
B : Letters may be lost 
C : Secrecy cannot be ensured 
D : Mail collected in time 

 
231  : Which state comes under postal zone 5? 
A : Gujarat, Rajasthan 
B : Goa, Maharashtra 
C : Andhra Pradesh, Karnataka 
D : Bihar, Jharkhand 

 
232  : What are the duties expected of the 
security guards? 
A : To deter theft and vandalism 
B : To detect theft and vandalism 
C : To observe theft and vandalism 
D : To deter, detect, observe and report theft 
and vandalism 

 
233  : Which option does not come under 
corporate sabotage? 
A : False data entry for illegal purposes 
B : Overcharging a friend 
C : Preparing ‘Ghost Payroll’ 
D : Forgery of cheques 

 
234  : Which is correct with regard to VPP (Value 
Payable Post)? 
A : The amount for remittance to the sender 
should not exceed Rs.10,000/- 
B : Articles sent by VPP can be either registered 
or unregistered 
C : Value of articles is paid at the time of receipt 
of articles 
D : Any unregistered article can be sent by VPP 

 
235  : What does an office need to do to keep it 
secure? 
A : Should set right machinery as soon as they 
break down 
B : Should allow visitors free access to 
employees 
C : Should put cash in cash boxes for safe 
keeping 
D : Should involve employees in safety planning 
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236  : Which should be borne in mind while 
writing a formal letter? 
A : Language should be grand and elaborate 
B : Language should be simple and clear 
C : Use ‘Yours sincerely’ if you do not know the 
person 
D : Use ‘Yours sincerely’ if you know the person 

 
237  : What do you know of ‘P.S’ found in some 
letters? 
A : It is written at the top left of the letter 
B : It is written at the right bottom of the letter 
C : It means ‘Post Subscription’ 
D : It means ‘Post Script’ 

 
238  : Which is a formal letter? 
A : Application 
B : Invitation letter 
C : Thanks giving letter 
D : Condolence letter 

 
239  : Which is correct with regard to formal 
letters? 
A : Signature below formal closing 
B : Reference line above subject line 
C : Subject line above salutation 
D : Name of addressee without title 

 
240  : Which option will demerit a complaint? 
A : If it is addressed to the right person 
B : If contact number and address are furnished 
C : If action to be taken is stated 
D : If written with all details added clumsily 

 
241  : Which is correct for a social letter? 
A : Salutation begins with ‘Dear............’ 
B : Complimentary close is ʹYours sincerelyʹ/ 
ʹYours trulyʹ 
C : Date is written at the bottom of the letter 
D : Contents of the letter are to the point 

 
242  : What is the main issue that the agenda 
should focus on? 
A : Mapping out how much time each item will 
take 
B : Giving importance to issues that affect a large 
number of people 
C : Listing of items to be discussed 
D : Including names of participants 

 
243  : What is not relevant to a ‘Memo’? 
A : Memo is the abbreviation of the word 

‘memorandum’ 
B : It is a document recording terms of contract 
C : It is an informal letter without signature 
D : It does not convey messages across a large 
organization 

 
244  : Which is true of an agenda? 
A : Not all the points in the Agenda will be 
discussed 
B : Agenda and notice are not sent together 
C : The aim of agenda is to prepare participants 
for discussion 
D : A decision may not be arrived at the end of 
discussion 

 
245  : What are the features of banking 
correspondence? 
A : Banks protect their interest at the clients’ 
cost 
B : Banks call a client a bad debtor hastily 
C : Banks judge a situation from the client’s point 
of view 
D : Banking correspondence need not be 
confidential in nature 

 
246  : How will you choose to end a condolence 
letter? 
A : Sincerely 
B : You are in my thoughts 
C : Love 
D : Fondly 

 
247  : Which guideline should be followed for 
writing a condolence letter? 
A : It should be in poetic form 
B : It should be sent promptly 
C : It should be typed on computer 
D : It should never be hand-written 

 
248  : Which is an formal letter? 
A : Condolence letter 
B : Thanks-giving letter 
C : Invitation letter 
D : Application 

 
249  : What is true of a quotation? 
A : It mentions the buyer’s terms of agreement 
B : It is not time bound 
C : It mentions the seller’s terms of agreement 
D : It is issued before enquiry is made 
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250  : What is true of an ‘enquiry’? 
A : It is written by the seller to the buyer 
B : It is a letter in response to the quotation 
C : It is a letter by the prospective buyer to the 
seller 
D : It does not specify the products 

 
251  : Which is very essential in a quotation? 
A : Warranty of product 
B : Quantity of product 
C : Discount offered for the product 
D : Name and details of product 

 
252  : What should a letter of congratulation 
satisfy? 
A : It should be written in a high-flown language 
B : It should never be hand-delivered 
C : It can be hand-written in a simple language 
D : It should not be rushed through 

 
253  : What do you know of a savings account in 
a bank? 
A : Money cannot be transferred online 
B : Cash cannot be withdrawn any time 
C : Cash cannot be deposited any time 
D : Interest offered is low 

 
254  : What do you know of current account in a 
bank? 
A : Cheque books are not issued 
B : Credit limit cannot be availed if there is no 
balance 
C : No interest is paid by the bank 
D : Business transactions are carried out 
sluggishly 

 
255  : Which is apt for a overdraft account? 
A : Interest rates are very low 
B : Overdraft limit cannot be changed any time 
C : Money can be withdrawn if the account 
balance is zero 
D : Bank cannot demand pay back of overdraft 
at any time 
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